Humboldt County
Digital Standards and Style Guide

Last Updated: Dec. 22, 2025
Table of Contents

Humboldt County Digital Standards and Style Guide ...........cccevveeeiiviiiiieeieiiiceeeees 1
INEFOAUCTION. ..t e e et e s e s e e e e e nneesnnee s 3
GUIAING PriNCIPIES wvveeeieiiieee ettt ettt e e e s s saae e e e e sbaaeeeesabeeeessnns 3

B Fq i =1 I @leT o} =T o | AR PPPPPPPPPRt 4
LTSI (oY = ={ PP PPPPPPPPPPPPRE 5
FIlE SIZE unnitiiee ittt e e e s b e e e et e e e e abaeeeesaaaeeas 5
(@1 oYV 1 4 (o] o VSRt 5
DOCUMENT STFUCTUIE ...eiiiiiiiiiiiiiitiec e 6
TitleS & HEAUINES .ceeeiiiiiiiiiiiiiieeeeeeeeeeeeee ettt e et eeeeeeeeeeeesaeaaaaesasssassesesssssassssssearaeees 6
TABIES et e e e r e e e e e nneas 7
TEXE BOXES ..eeviiiiiiiiiiiiiiiiiiiiiiiiii ittt 7
LISES ettt e e 7
LIS e s et e s e e e e s r e e s neee e 8
[0 F= =TSP 8
FOrmatting & Grammar.......oo oot e e e e e et e e e e e e e e e e aasaaa e e e eaaanes 9
(@Y T 1 - [7- ) 4 Lo o [P 9
FONES 9
Grammar & TONE.....coiiiiiiiii it e s 9
Numbers, Dates & PerCeNtageS......uuuiiiiiieiiiiiiiiee et e e e e e e e e e e e e e e e eanees 10



Addresses, Phone Numbers & TIMES ......coovvvviiiiiiiiiii 10

WEDSITE MOUIES ...t as 11
ABENAA CONLEN .o 11
ATCRIVE CONTEN ...ttt et e et e e st e e s bt e e st e e e saseeesnneeenes 11
Boards & COMMISSIONS ......eeiiiiiiiiiiie ettt e e 11
DOCUMENT CONTEN....uuiiiiiiiiiiiiiiir e 11
X @ TP PPPTRUPPPOPPPTOPPRON 12
FOrM CONTEN coiiiiiieeccc e 13
INFO ADVANCEA ... s e s nne e 13
MENUS & NAVIZATION ...uiiiiiiiiiiiiiiee e e s s e e e e e e e s e s s ssaanes 13
Page Descriptions & KEYWOIAS .........uuvvurreiririririrerererreeereeerereeerrereeerrrerereeer..—.—————.. 14
PaBES WIBET .ottt e s e e e e e e s et ae e e e e e e e e e e e aaane 14
Y R I =Tl | 1 =TSP UPRPRPPNS 14
QUICK LINKS <. s s e 15
) =Y DT = Tot oY YRR SP 15

Copyrighted Materials/Fair Use/Intellectual Property .......ccceeeeeeeeecveeeeveeceireee e 16

ADA COMPIIANCE...ciiiiiiiiiiiiiiieiieeeeeereeeeeeeeeeeeereeeeererereeereresrsrrrerrarssrarrrrrrrrrsrrrerrrrrrrrssrsrrrrree 16
WOrd DOCUMENTES ...ttt e 17
P DS ettt st b e bt b b s b ar e nars 17
WEDSITES ettt e 17

Humboldt County Digital Style Guide Quick Reference Sheet.........cccceeeeeeieeennnnns 19

VISUAIS ..t 19

o aTe T de =4 =T o] o F PP PPPPPPPPRt 19

AAP STV vttt ettt ettt et et et et a ettt n et et e e en e e et et s enee et en e aeneeaeas 19

B =d R I LYo F= T e [P PPPPPPPPRt 19



Introduction

Guiding Principles

The Digital Standards & Style Guide is a tool to help improve user experience with the
county’s digital media, including our public website (humboldtgov.org), employee
website (employees.humboldtgov.org) and all other shared digital content. Additionally,
the Digital Standards & Style Guide is an implementation tool for the Digital Accessibility
Policy, which includes the following.

This guide was initially created during the development of county websites, with
feedback from the public and employees. It has been created to change over time.

Goals for all digital media:
e Well organized
e Easy to understand
e User-friendly
e Accessible (see ADA Compliance section)

Goals specific to the websites:
e Correct, current information
e Modern look, feel and functionality
e Maintains site consistency
e Stores appropriate and organized documents
e Sources documents to guide decisions
e Responsive to the needs of the public and employees
e Promotes Humboldt County

We must deliver clear, concise, well-formatted content to meet the goals stated in this
document. Therefore, the county has adopted best practices to help users develop and
maintain content. This guide was created using some of the foremost authorities in
website usability as references, as well as expertise from county employees. It is
intended to be consistent with the county’s Agenda Item Style Guide, which is based on
the writing standards in the Associated Press Style Guide.

Use this guide when creating new content, or when reviewing and making significant
changes to existing content. The main types of digital content produced by the county
are outlined below.



Digital Content

Documents

Most documents start in Microsoft Word and then are exported as a PDF for distribution
(usually to the website).

PDFs should be viewed as a “snapshot” of your source document. Directly editing PDFs
should be avoided. Instead, always keep your source documents to make future
changes. The standards and styles provided in this guide are easiest to apply directly to
source documents.

Whenever possible, avoid PDFs entirely and create content directly as a web page
instead.

Websites

The county has two main websites that host many pages, documents and media:

e Public website (humboldtgov.org) — This website provides information about our
services to the public and allows residents to do business with us.

e Employee website, HumNet (employees.humboldtgov.org) — This is our internal
website for employees, and it cannot be accessed by the public.

Departments designate staff to edit web content and use a variety of tools to help
engage users. Currently, there are over 100 employees who work on the website.

With so many web editors, we must ensure a consistent look and feel so that users can
easily find what they need. This style guide will help with presenting web content in a
way that ensures consistency throughout the sites. The general guidance in this
document also applies to our websites. Additional information more specific to the
website is also included throughout this guide and will be clearly labeled.

Media

Additional media shared by the county includes videos, maps, diagrams, social media
and more. Since media can vary so greatly, the guidance provided here will focus on
websites and documents. However, the principles described in this document should be
applied to all digital media whenever possible.


https://humboldtgov.org/
https://employees.humboldtgov.org/

File Storage

Official county documents that others reference and rely on should be stored within the
county’s internal file system and then added to county websites as appropriate.

Some common documents we want to easily be able to reference are policies,
procedures, forms and reports. To ensure that these documents can be easily accessed,
try to limit file sizes and use organization schemes when grouping similar documents.

File size

In general, try to break up large files into smaller files and rely on an organization
scheme to keep them grouped together. If you must share a large document, let the
user know the file size and type (Response Times: The Three Important Limits, Nielsen).

Organization

Documents need to be organized and displayed in ways that makes sense to relevant
users (both readers and collaborators).
e All documents should be named in a way that clearly states what it is.

e Use an organization scheme to ensure users can find similar documents
(Classification Schemes—and When to Use Them, Spencer 2010).

Organization schemes have to do with how you are going to categorize and relate your
content. Most content can be categorized in the following ways:

e Alphabetical

e Chronological

e Geographical

e Topic

e Task

e Audience, or

e Metaphor
The default organization scheme will be by department > division > topic or task > and
then displayed alphabetically.

Websites

The websites use the Document Center for file storage.



https://www.nngroup.com/articles/response-times-3-important-limits/
https://articles.centercentre.com/classification_schemes/

Document Structure

Titles & Headings

Titles & headings are used to clearly label the content that follows them. The title
should apply to the entire document or page, and headings should apply to specific
subsections of that content.

e Titles and headings should be in title case with clear and concise names.

e Use headings to break up content in a logical, organized way.

e Utilize the ampersand (&) to save space.

e Break up content into small, easily readable chunks.

Many text editing applications allow you to set titles and headings in a similar way. Titles
are often set under document “Properties” and headings are often set under “Styles”.
Below are instructions specific to the website, Word and PDFs.

Websites

e Headings: In the Editor widget, use the dropdown to select “Subheadl” or
“Subhead2” based on the hierarchy of information on the page. Make a choice
based on structure, not on color. Only use “Subhead2” when nesting information
that is related to the Subhead1 topic before it.

e Page Titles: Click the page title to edit it. Alternatively, use Versions > Actions >
Options.

Word Documents
¢ Headings:
o Set headings using the “Home” tab > “Styles” section > Select appropriate
heading level
o Review heading using the “View” tab > “Show section > Check box for
“Navigation Pane”
e Document Title: Set the title under “File” tab > Info > Title (on the right)
e See Document Accessibility Basics for additional guidance.

PDFs
e Headings: Review and set headings using the “Accessibility” tool> “Reading
Order”
o Note: This should not be necessary if the document was created and exported
properly from Word (and most other applications).
¢ Document Title: Set the title under “File” > “Properties”



https://employees.humboldtgov.org/DocumentCenter/View/18291/Document-Accessibility-Basics

Tables

e Do not use tables for formatting.

o Instead of using a table to place content side by side, use a column.

o Instead of using a table to list out items in a single column, use a list instead.
e The information in the table must relate to the heading prior to it.

e Numbers should be right aligned in tables unless it causes other information to be
difficult to read.

e Table need to be simple.
o Do not merge or split cells.
o Include labels and summaries of tables outside of the table itself.
o Include data in every cell and be consistent when leaving cells empty on
purpose, such as “N/A” or “-”.
o Ifit seems impossible to make a table simple, it is a sign it should be broken up
into multiple tables.

Text Boxes

e Do not use text boxes. Many screen readers are unable to access their content.

e Instead, place the text directly within the document.
o Borders can be used to make a section stand out in a similar way to a text box.
o Columns can be used to format it next to text.
o For example: See FAQs.

Lists
e Long lists within text should be turned into bulleted or numbered lists so that
they can easily be scanned.

e Use bulleted lists when order does not matter and numbered lists when order
does matter.

e The first letter of each list item should be capitalized.

e Use alphabetical order whenever it would help with navigation.

e For consistency, each list item should contain the same format (such as using
sentences vs. phrases) and verb tense.

e Avoid going more than 2 levels deep.

e Lists cannot contain complex structures such as tables or headings within them.
Keep lists simple. Replace them with numbered headings if they need to be more
complex.



Links

Use links to avoid duplicating information.

When linking to a PDF, indicate it at the end of the linked text using “(PDF)”.

Don’t create vague links, like "click here", since it’s not clear where they go.

o For example: use “View the training document.”, not “click here to view the
training document”)

Be the authority when you can, but don't create content you are not the

authority on.

o For example: To educate citizens on disaster relief and emergency
management using the same tools as FEMA: link to the FEMA website, don't
replicate their information. This allows easier access to current information for
our residents.

o When linking to external sites, try to link only to other government agencies,
non-profits, community organizations and businesses with whom the county
contracts. Commercial organizations often solicit the county to include their

link or information on the county’s website, which should generally be avoided.

Images

Images should only be used when they enhance the content on the page. All
images that provide information require alternative(“alt”) text that fully describe
the image in case it is not possible to view it.

Avoid images with a lot of text. Convert it into actual text instead.

o When text is included in an image, it must all be fully described. Either in alt
text, next to the image, or in a supplemental document.

Image resolution should be 300 dpi (dots per inch)(Image Resolution, Kilpatrick).
Use a photo release form whenever using a photo that displays a person’s face.

o Ingeneral, avoid posting pictures of minors. The county has approved photo
release forms you can use, but it is often more difficult to get these forms
filled out and signed properly.

Be aware of copyright laws when posting pictures (See Copyrighted Materials)

Images should be sized to fit within their content area and must be in-line.

o Do not use text wrapping, instead use columns (Word) or a separate
widget(website) to place images and text side by side.

Image file sizes should be minimized while still providing a quality image.

Websites

The website uses the Document Center to store images.

8



https://employees.humboldtgov.org/DocumentCenter/View/18005/Accessible-Word-Document-Training
https://employees.humboldtgov.org/DocumentCenter/View/18005/Accessible-Word-Document-Training
https://signalinc.com/the-clients-guide-to-image-resolution-infographic/
https://employees.humboldtgov.org/formcenter/county-employee-news-23/photo-submissions-250

Formatting & Grammar

Capitalization

”

The words “city,” “county,” or “town” (also borough, village, district, etc.) are
never capitalized unless they are stated in that entity's proper name (ex: the
“County of Humboldt” vs. the city). The same rule applies to "state."

Do not use all caps to emphasize an important point. Capitalizing all the letters in
a word has been found to decrease a reader's ability to quickly discern what the
word is. If you need to emphasize a piece of content, use bold instead.

Fonts

Preferred font families for county documents are Calibri, Arial and Montserrat.
When editing the website, use the default fonts.

A minimum font size of 12 pt. is required, though a larger size, such as 13 pt., is
suggested.

There must be strong color contrast between the text and its background for
readability.

Underlining should only be used for hyperlinks.

Avoid using all caps, especially within a block of text, for anything but acronyms.
If you need to emphasize something, use bold instead. Using all caps can make
the words more difficult to read.

If copying from another source, make sure to paste all items in plain text or
merge to the source. This will clear any formatting or text class information from
the previous source that may be left on the text.

Do not use strikethrough. Some devices, such as screen readers, are unable to
determine that the text is crossed out.

o For example: Use “Closed roads: Broadway St, Clark St.” instead of implying it

is closed with strikethrough: “Breadway-St-Clark-St."”

Grammar & Tone

Content should be grammatically correct and written in clear, concise sentences.
Do not use run-on or fragment sentences.
Be consistent with your sentence tense.

The average U.S. citizen reads best at an 8th or 9th grade level, so it’s important
to keep your content simple. You can use the Flesch-Kinkaid reader in Microsoft
Word to determine the current reading level of any piece of content.

Avoid using multiple punctuation marks in a row. For example, use “wow!"


https://support.microsoft.com/en-us/office/get-your-document-s-readability-and-level-statistics-85b4969e-e80a-4777-8dd3-f7fc3c8b3fd2
https://support.microsoft.com/en-us/office/get-your-document-s-readability-and-level-statistics-85b4969e-e80a-4777-8dd3-f7fc3c8b3fd2

instead of "wow!!!!" or "what?" instead of "what???". Exclamation points should
be used sparingly.

Know your audience. Is the content meant to engage, inform, educate or simply
direct the user to a specific resource? Most content is not meant to do
everything. Make sure you keep your audience and the purpose of the content in
mind.

It is okay to write in a more conversational tone for a lot of our digital content,
such as web pages or social media posts. However, slang and jargon should still
be avoided.

Avoid writing in the passive voice. The active voice is more engaging and direct.

o For example: “Action on the bill is being considered by the Board” is passive
voice. “The Board is considering taking action on the bill” is active voice.

Numbers, Dates & Percentages

Numbers: Use numbers as figures(not spelled out) so it’s easy to find/scan them.
For example: "Please submit 3 copies of the form."

In tables, right-align numbers unless it makes it hard to read (see also: Tables).
Percentages: Use percent symbol (%) instead of word “percent” for readability.
Date Examples: “March 1, 2023”, “Feb. 10”, “The event is scheduled for June 1.”

Addresses, Phone Numbers & Times

Formatting for contact information:

8a.m.-5:30 p.m.

Ph: XXX-XXX-XXXX

FX: XXX-XXX-XXXX

Street Modifiers -Abbreviate St., Ave., and Blvd. Spell out all other identifiers.
Street Numbers - Use figures for 1st St., 2nd St., etc.

Addresses within Text:
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Use an address block when an address is listed within page content.

If you have a separate physical and mailing address, list the physical address in a
separate block from the mailing address to enable users to easily highlight and
search for directions. (See “Staff Directory” example)

If the address has a P.O. Box but the same zip code as the physical address, the
P.0. Box info can be listed on the second line of the address.

Room, floor, suite, etc. is listed out on the second line of an address block.
o If thereis also a P.O. Box in the address, the floor; suite, etc., - would still be



listed above the P.O. Box.
e Use figures for numbered streets such as 1st Street.

Websites

The website uses the Staff Directory module to share contact information & business
hours relating to our departments, divisions, programs and staff. Within the “Website
Modules” section, see Staff Directory for more information.

Website Modules

Agenda Center

The Agenda Center should be used to house agendas and complimenting minutes and
packets. They should be in order by the document date, starting with the most recent.

See Web Editing Best Practices for more information.

Archive Center

The Archive Center should house: Items such as newsletters, police reports, press
releases, etc. that are frequently published and should be sorted by date, documents
that are updated frequently such as budgets, financial reports, etc.

Boards & Commissions

Boards & Commissions pages should be linked from the Boards, Commissions, and
Committees page. Please work with the Clerk of the Board’s Office to make changes to
the listing on this page.

When creating or updating a board page, be as consistent as possible when displaying its
information by:

e Organizing content in the same order from board to board
¢ Including all pertinent information about how to join or who to contact

e Linking to any applicable documents such as agendas and minutes on the board
page

Document Center

Use the Document Center module to store documents on county websites.
e Only upload necessary documents.
e All documents should be named in a way that clearly states what it is, using as

11


https://employees.humboldtgov.org/1025/Web-Editing-Best-Practices
https://humboldtgov.org/168/Boards-Commissions
https://humboldtgov.org/168/Boards-Commissions
mailto:cob@co.humboldt.ca.us

few words as possible.

within the “File Storage” section).

¢ If additional details would be helpful, include a document description.
e General organization should reflect department structure (see Organization

e When a document has been updated, locate the previous version and replace it.

This will help avoid links from breaking and make it easier to locate current

information.

Public Images

“Public Images” (formerly called “Image Repository”) is a section of the Document
Center meant to store images such as site banners, background images and graphic link
icons. Please be aware that any images published here can be accessed by anyone who
has a link to them (even on HumNet, the employee website).

Remember to add alt text for all images. If alt text needs to change for a specific page, it
can be overwritten there. But having good alt text with the source image will usually
prevent duplicate work.

FAQs
e All FAQs should be housed within

12

the FAQ module to best utilize
the CivicPlus platform.

Each department is encouraged
to provide citizens with answers
to a useful set of FAQs.

If there are more FAQs than can
practically be displayed within
the module widget on a page, link
a subpage directly to that FAQs
category so that all FAQs can be
quickly and easily found.

FAQs should be formatted in a
way that makes the answer
immediately clear but is not too
abrupt (see example to the right).

FAQ Example
Q: Can | pay my bill online?
Poor answer: Yes.

Poor answer: The system allows you to
pay your bill online.

Best answer: Yes, please visit our Online
Payments page to make a payment.



http://www.humboldtgov.org/1489/Online-Payments
http://www.humboldtgov.org/1489/Online-Payments

Form Center

The following types of forms work best in the Form Center:
e “Contact Us” forms, surveys or other simple requests.
e Forms consisting of mostly text fields (short and long answers) or multiple choice.
e Forms to be emailed to or accessed by a particular person or team to process.
e Forms that don't require an official signature or notary.
The following types of forms don't work as well in the Form Center:
e Forms containing a lot of text-based instructions or introductions.
e Forms that require attachments that the client has indicated cannot be copied.
e Forms that require an official signature or notary.

Do not use the Form Center to collect sensitive information(see CivicPlus’ Disclaimer).
Sensitive information includes:

e Bank Account Information

e Birth Certificate Copy

e Business ID Numbers

e Driver's License Numbers

e Medical Information

e Passport Numbers

e Passwords

e Routing Numbers

e Social Security Numbers (even the last 4)
e Tax ID Numbers

e W2 or Other Tax Information

Info Advanced

The Info Advanced module is used to display the same content on multiple pages. It
allows us to update content from a single location.

In the past this was often used to display our contact information and business hours,
however that should now be done through the Staff Directory instead.

Menus & Navigation

The websites have two navigation menus: The main menu across the top of our pages,
and the menu on the left side of subpages. The websites can also be navigated using the

13


https://www.civicplus.help/municipal-websites-central/docs/form-center-overview

site map (see Site Map (Public) and Site Map (HumNet)).

e Navigation menus should provide a good overview of relevant pages and services.

e Navigation menus should be listed in alphabetical order unless another order
would be expected (e.g. putting an “About Us” page first).

Page Descriptions & Keywords

Page descriptions & keywords should be completed for every page. This helps with
search results and can guide users to the correct information.

e Page descriptions should accurately describe the content on the page, including
any major topics covered. These are displayed when pages come up in search or
when using the Pages Widget.

e Keywords should include common words and phrases that people would search for
to locate your page’s content. These keywords are never directly displayed but are
used to improve search functionality.

Set page descriptions and keywords through Versions > Actions > Options >
Description/Keywords.

Pages Widget

The Pages Widget is used to create menu pages that display a listing of the subpages for
a parent page and their page descriptions. These pages help provide structure and
organization to the navigation. They should be used in conjunction with other content
to make a more robust landing page. However, it is not recommended this be the only
content on a main department landing page. Instead, feature relevant and actionable
content whenever possible.

Parks & Facilities

This is also referred to as the “Facilities” module. It is best used to hold information
about the following:

e Parks
e Rentable city/county facilities
e Trails
e Pools
e Community centers and meeting places
When adding or editing items to this module, keep these in mind:

e All facility amenities should be populated as “features”. If the amenities are not

14


https://humboldtgov.org/sitemap
https://employees.humboldtgov.org/sitemap

populated within the features section in the Facilities module, citizens will be
unable to correctly utilize reservations and will be unable to search or filter for
facilities by amenity.

e Use a specific address and the map location feature whenever possible.

e CivicPlus does not recommend use of the Facilities module to house business
information. The Resource Directory is designed to display information about
local businesses.

Quick Links

Category titles should be intuitively named using titles that make sense on their own and
out of the context of any surrounding text, because 1hey may be viewed from the main
Quick Link module landing page and will need to make sense standing on their own.
e Quick links should be intuitively named. Ask these questions:
o Does the name of the link make sense out of context?
o Isit dear where this link is going to take a citizen?
e Link titles should be in title case.

Staff Directory

Jane Doe

Website editors should display contact .
Department Director

information using the Staff Directory Email

module. This allows for department and Ph: 555-555-5555
staff information to be maintained and Physical Address
updated from a single location. An 12345 ABC Lane
example for the suggested format is Sl_JiFe 1

_ _ CivicCity, KS 66502
included to the right. View Map

The “about page” for each department Mailing Address
and division should have contact P.O.Box 123
information on the right-hand side of Fake, K5 66502
the page. This information should allow Ph: 555-555-5555

Fx: 555-555-5556

a person to get in contact with a main Emergency: 911

desk that can route their request.

Hours
This same format should be used on any (Excluding Holidays)
additional pages where contact Monday - Thursday 8 a.m. - 5:30 p.m.
information would be helpful to have for Friday 8 a.m. = Noon
Staff Directory
the user.

15


mailto:civicplusqualitycontrol@civicplus.com
http://maps.google.com/
http://www.humboldtgov.org/Directory.aspx?DID=3

Copyrighted Materials/Fair Use/Intellectual Property

e All employees are prohibited from copying materials not specifically allowed by
copyright law, "Fair Use" guidelines, licenses or contractual agreements or the
permission of the copyright proprietor. Web pages must include a statement of
copyright when appropriate and indicate that permission has been secured when
including copyrighted materials and that such publication is in accordance with
the "Fair Use" provisions of the copyright law.

e Fair use provisions allow for copyrighted material to be used for the purpose of
criticism, comment, news reporting, teaching, scholarship or research. However,
information on a website may not be covered by these provisions because they
could be widely disseminated since they are available on the Internet. Therefore,
you should get permission of the copyright holder before posting copyrighted
information.

e Unless otherwise noted, always assume that work (including photographs, text,
music and graphics) on the Internet is copyrighted. It is NOT necessary that the
copyright symbol (©) be displayed for the work to be protected by copyright laws.

e Proper attribution must always be given per the organization or the individual.

e Obtaining permission from the copyright holder should occur during the
developmental process of the project, rather than waiting to seek permission
upon completion of the project.

e Unauthorized electronic transmission of copyrighted materials is illegal.

e Any permission obtained from a copyright holder for text, pictures, graphics,
music or other copyrighted material should be given to your department’s
content owner.

e CivicPlus has guidance on finding free to use images.

ADA Compliance

Humboldt County is committed to provide and maintain accessible information for all
residents and employees, and this includes digital content.

The Americans with Disabilities Act(ADA) includes digital accessibility requirements and
references a technical standard we must meet through the Web Content Accessibly
Guidelines (WCAG) Version 2.1, Level AA. The county’s Digital Accessibility Policy also
requires that “Individuals responsible for maintaining and updating the county’s

16
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website, digital services, internal and external communications and mobile applications,
including social media platforms, shall have a working knowledge of accessibility
requirements. To that end, identified staff, including all web editors, are required to
annually participate in a minimum of two hours continuing education and training
related to digital accessibility as approved by the county Webmaster. Related training
requirements are listed on the county’s internal Annual Accessibility Training page”

HumNet’s Digital Accessibility Guidance page holds a collection of digital accessibility
information and resources for county employees. That page and this guide have been
created to assist county content creators to stay in compliance with the ADA and our
Digital Accessibility Policy.

In the event that these supplemental resources conflict with the Board adopted Digital
Accessibility Policy, the Digital Accessibility Policy shall govern.

Some additional tips & tricks that are specific to Word, PDFs, and our websites are

below.

Word Documents

By using the guidance in this document, you will be on the right track for creating
accessible Word documents.

Be sure to also use the built-in accessibility checker available in the “Review” tab >
“Accessibility” section > “Check Accessibility”.

Additionally, if creating a PDF from the Word document, it must be saved properly.

See Document Accessibility Basics for instructions.

PDFs

If your document was originally created in Word, start with the previous section since
that is the easiest way to create an accessible PDF.

Otherwise, remediation is likely required to make the PDF accessible. See: Create and
verify PDF accessibility, Acrobat Pro.

Websites

The websites have a built-in accessibility checker within the editor widget, which should be
utilized whenever changes are made.
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https://employees.humboldtgov.org/581/Annual-Accessibility-Training
https://employees.humboldtgov.org/470/Web-Accessibility-Guidance
https://employees.humboldtgov.org/DocumentCenter/View/18291/Document-Accessibility-Basics
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
https://www.civicplus.help/municipal-websites-central/docs/accessibility-content-checker

We also use site scanning technology with our vendor Siteimprove to ensure compliance
with the ADA. See HumNet's Siteimprove Reports page for more information.

Our website vendor, CivicPlus, has also identified practical accessibility tips for local
governments as stated below:

1. Ensure Content has Appropriate Headings and Titles: Users may struggle to
navigate your website if headers aren’t used or if they’re used decoratively.

2. Use Text and Font to Benefit Users: Color should not be the only thing used to
differentiate information as it will not be readable for people with low vision or
blindness. Also, avoid dense paragraphs of text for readability.

3. Don’t Use Tables for Page Layouts: Tables are meant to serve a specific purpose:
to showcase data. Using them to create page layouts can be confusing for
residents who use assistive technology to interpret online content.

4. Identify Visuals with Alternate Text: If there is no text accompanying an image, a
visually impaired person’s screen reader cannot identify it.

5. Use Color Contrast: Some people may have trouble reading text that does not
contrast with its background. All text should have a color contrast ratio of 4.5:1
so that all residents can view information online.

6. Ensure Navigability: People who use assistive technology must be able to
navigate a website using a keyboard and keyboard equivalents. Keep information
in a consistent location and bear in mind that screen readers move top to bottom
to create an intuitive user experience.

7. Avoid Using PDFs: Image-based formats are not easily read by screen readers,
making them difficult to access for people with visual impairments.

8. Enhance Your Multimedia: Don’t forget to add audio descriptions to images and
text captions for users with hearing impairments.

9. Include “Skip Navigation” at the Top of Your Pages: Screen readers dictate to
people what a website says. By allowing them to skip the navigation menu,
they’re able to go directly to the content they need.

For more specific details on WCAG 2.1, please refer to the Web Content Accessibility
Guidelines (WCAG) 2.1.
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https://employees.humboldtgov.org/993/Accessibility-QA
https://www.civicplus.com/blog/wa/how-local-governments-build-trust-through-accessibility/#title-2
https://www.civicplus.com/blog/wa/how-local-governments-build-trust-through-accessibility/#title-2
https://www.w3.org/TR/WCAG21/
https://www.w3.org/TR/WCAG21/

Humboldt County

Digital Style Guide Quick Reference Sheet

Visuals

Avoid clipart
Always use descriptive alt text.

o Try “Softball player holding red
glove” instead of “Girl.”

Choose fonts for readability in
context

Consider size, sequence
Emphasize effectively
Use contrast, not just color

AP Style

Consult the AP Style Guide.

Dates: Jan. 25, December 2015
Times: 1to 4 p.m., 1:25 p.m., noon
Addresses: 123 First St.

Phone numbers: 707-123-4567

Photographs

Take photos

Phone photos are fine, but take
several

Come in tight on subjects
Pose groups creatively
Go outside

Send releases when submitting
photos

Get releases — every time.

No minors, no clients, no foster—
never ever, ever

Beware copyright violations.

Digital standards

Keep it relevant to the people we
serve; don’t use web pages as a
storage repository.

Put it on a page, not a PDF
Minimize clicks and keep files small
Break it up: Use headings, bullets
and white space

Strive for screen reader compliance
Offer media alternatives: Provide

transcripts for any audio or video
content

Link, don’t repeat: Don’t duplicate
content, link to sources

Call it what it is: Name links
intuitively.

Organization: Follow department
structure
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